
Introduction

The Waste Reduction Algorithm Graphical User Interface (WAR GUI) was 
developed to compare the environmental friendliness of chemical process designs (
Hilaly and Sikdar, 1994).  The WAR GUI does not contain a process simulator.  
However, the interface allows the user to enter process design information for 
several different designs in order to compare them on an environmental basis.  The 
pertinent process design information includes the chemicals used, the flow rates of 
the streams entering and leaving the process, and the energy usage of the 
process.  

The WAR algorithm involves the concept of a Potential Environmental Impact (PEI) 
balance (analogous to a mass or energy balance) (Cabezas et al., 1999).  The 
balance involves the flow of environmental impact across system boundaries (as 
opposed to mass or energy).  The flow of impact can be due to mass or energy 
crossing the system boundaries (Young and Cabezas, 1999).  From the PEI 
balance, PEI indexes are calculated which provide a relative indication of the 
environmental friendliness or unfriendliness of the chemical process.  

Theory

The overall impact balance for a general chemical process is illustrated in Figure 1:

 

Figure 1. The overall impact balance around a chemical process facility including 
the energy generation facility.  The system boundary is designated with a dashed 
line.

The potential environmental impact balance is as follows:



 (1)

For steady state processes, Equation (1) reduces to

 (2)

The waste energy emissions of both the chemical process and the energy generation 
process will be neglected since these will have minor impacts when compared to the 
amount of energy and materials that are consumed and produced through 
non-fugitive streams.  Also, the impact of the input streams to the energy process will 
be neglected (Young and Cabezas, 1999).  This reduces Equation (2) to

 (3)

The environmental impact of the energy usage of a chemical process is accounted 
for in the impact of the streams leaving the energy generation process (expressed in 
the third term in Equation 3).  Click here for more information on the calculation of the 
impact of energy generation.

This can be re-written yet again as

(4)

The total input rate of PEI can be approximated by known and measurable 
quantities by

 (5)

In the current version of WAR, the combinatorial effects resulting from chemical 
mixtures (the additional terms given in equation 5) are neglected.

The normalized impact score for chemical k for category i is calculated using the 
following normalization scheme:



 (6)

Potential Environmental Impact Indexes

Equations 4-6 can be used to generate indexes that characterize the relative 
environmental efficiency of a process.  There are two different classes of indexes: 
those associated with PEI output and those associated with PEI generation.

The total output rate of PEI (or total output PEI index) can be approximated using 
an equation similar to the one used for the total input rate of PEI:

 (7)

In the calculation of the output PEI index the user can decide whether or not to 
include the impact of the product streams.  For example if the product is the 
feedstock for another process one may not want to include its impact in the 
analysis.  

The total PEI generation rate (or total PEI generation index) can then be 
calculated from Equations (4-7).

The output and generation PEI indexes can be evaluated on rate basis (PEI/time) or 
on a production basis (e.g. PEI/mass of product).  The indexes presented so far are 
in terms of rate evaluations, PEI/time.  To evaluate the PEI output index on a 
production basis, a simple transformation can be made

(8)

A similar transformation can be made to convert the PEI generation index into terms 
of PEI/mass of product



(9)

The intended use of the WAR Algorithm is to provide a means for comparing the 
PEI of alternative designs for a process.  In the WAR Algorithm, the four indexes 
shown in Equations (8-9) are used to compare the environmental friendliness of the 
possible process designs.  Designs with lower PEI index values represent more 
environmentally desirable designs.  

For a more detailed discussion on the interpretation of the results from the WAR 
GUI, click here.

Click here for Nomenclature

Specific Chemical Environmental Impacts

To provide an indication of the potential environmental impact of a chemical 
process, a database of relative environmental impact scores has been created for 
as many as chemicals as data are available drawing on government and 
non-government sources.  

Eight different categories of impact potential are considered:

Human Toxicity Potential by Ingestion or HTPI,
Human Toxicity Potential by Inhalation or Dermal Exposure or HTPE,
Ozone Depletion Potential or ODP,
Global Warming Potential or GWP,
Photochemical Oxidation Potential or PCOP
Acidification Potential or AP,
Aquatic Toxicity Potential or ATP, and
Terrestrial Toxicity Potential or TTP.

Weighting Factors

Weighting factors are used to combine PEI categories into a single PEI index (see 
Equations 5 and 7).  They represent the relative or site-specific concerns of the 
user.  For instance, if the user was evaluating a process that was located in the Los 
Angeles area the weighting factor for smog formation (PCOP) would probably 
receive a high value.  Whereas, if the user was evaluating a process in the 
Northeast the weighting factor for acid rain (AP) would probably receive a high 
value.  The default values used in this program weight all the categories equally.  



The user, however, has wide latitude to weight the relative importance of these 
environmental effects to suit particular applications.



Nomenclature

In order of appearance:

 

Continued...



 



Interpretation of the results of the WAR GUI

The WAR GUI allows the user to calculate several potential environmental impact 
indexes.  In general processes with lower PEI indexes will be more environmentally 
friendly.  From the PEI indexes one can identify the most environmentally friendly 
process design from several alternatives.  However, the need to design processes 
with lower PEI must be constrained by the considerations of engineering economics 
and the human need for the products that the process manufactures.

The total output rate of PEI allows one to compare alternative processes in terms 
of the potential effect on the environment external to the process.  The total output 
rate of PEI is most useful in assessing whether a particular site is able to 
accommodate a given process plant.  For example a process with a low output rate 
of PEI could be located in a more ecologically sensitive area than would be the case 
for a process with a high rate of impact output.

The total generation rate of PEI allows one to compare different processes in 
terms of their generation of new PEI within the process.  The generation rate of PEI 
is important because once it is created, it will likely take resources to keep the PEI 
from becoming actual impacts on the environment.  The total generation rate of PEI 
allows one to determine if the chemical reactions occurring within the process 
produce products that are less environmentally friendly than the feed stock 
chemicals.  

The total PEI leaving the system per mass of products and the total PEI 
generated within a system per mass of products allow one to compare 
alternative processes regardless of the manufacturing plant size.  For example, one 
can compare the environmental consequences of having one large plant versus 
several small ones.  The amount of PEI per mass of products decreases if the 
amount of PEI emitted has decreased or because the mass flow rates of the 
product streams have increased or both.  This illustrates that by lowering the 
amount of PEI per mass of products one also improves the material utilization 
efficiency of the process.

Product vs. Nonproduct analysis
The default setting for the program is not to include the environmental impact of the 
product streams in the analysis.  In general one should not be penalized for 
manufacturing a product that has market value.  Thus one should focus on 
minimizing the environmental impact of the waste streams, the by-product streams, 
and the energy produced by the process.  One should include the impact of the 
product streams if a stream is likely to be emitted into the environment (e. g. 
consumer products) or if one is evaluating several different product alternatives.  
One should not include a product if the product is simply an intermediate product 
that will be directly used as a feed elsewhere in the manufacturing facility.
 
 



Impact of energy consumption
The energy consumption of a process has an effect on the total potential 
environmental impact of a process (click here for further information).  In general a 
reduction in the energy consumption of a process will also reduce the potential 
environmental impact of a process.  However in some cases decreasing the energy 
usage may increase the PEI of a process.  For example if one decreases the reflux 
ratio of a product distillation column the energy usage will decrease but the 
separation efficiency will also decrease.  This causes a larger amount of the product 
to be present in the waste stream, which then may increase the PEI of the process.  
One may choose not to include the impact of energy generation if the energy 
generation is unknown or is assumed to have a negligible impact.



Tutorial

In this tutorial we will evaluate the environmental friendliness of two process designs 
used to  produce phthalic anhydride.  The first design produces phthalic anhydride 
from o-xylene and the second design produces it from naphthalene.  The process 
flow diagram for the process that uses o-xylene is as follows:

 

The first step is to create a new case history file.  Do this by clicking on the New 
case history file button (located next to Step 1).  This creates a blank case history 
file ("Untitled.war").

The second step is to add the first case study.  Open the Add case screen by 
clicking on the New case study button (located next to Step 2).  Case studies that 
will be compared are stored in the same case history file.

Name the first case study "Unit 700" (in the text box next to Step 2a).

For the description of Unit 700 type "o-xylene feed stock" (Step 2b).

Once the case study is added to the case history file, the next step is to add 
chemicals to the case study.

Click here to proceed to the next step.



Adding chemicals to the Unit 700 case study

Open the add chemicals screen by clicking on the Edit/Add Chemicals button 
(Step 2c).  Chemicals can be added to the case study by a number of ways.  This 
tutorial will discuss them all.

First, we’ ll add chemicals by using the Chemical Abstract Service (CAS) registry 
number.  Click on the Search by CAS Number option button.  This loads a list of 
CAS numbers.  The first chemical we want to add is phthalic anhydride.  Type 
"85-44-9" in the search text box.  When the CAS number for phthalic anhydride 
appears, single click on it.  This will display "phthalic anhydride" in the name box 
below the list of CAS numbers.  The chemical can be added to the case study by 
double clicking on its CAS number in the list or by clicking on the Add from list 
button.

Next, we’ ll add chemicals by their name.  Click on the Search by Name option 
button.  This loads a list of chemical names.  The next chemical we want to add is 
"maleic anhydride".  Type "maleic anhydride" in the search text box.  When "maleic 
anhydride" is highlighted in the list box add it to the case study.

Next, we’ ll add chemicals by their chemical formula.  Click on the Search by 
formula option button.  This loads a list of chemical formulas.  The next chemical 
we want to add is o-xylene. Type its formula (C8H10) in the search text box.  
Double click on the formula when it appears.  This brings up a list of all chemicals in 
the database with this formula.  If one clicked on the wrong formula one can reload 
the list of formulas by clicking on the Up button located next to the list box.  Add 
o-xylene to the case study.

Next, we’ ll add chemicals by the substring of their name.  Click on the Search by 
Substring option button.  The next chemical we want to add is oxygen.  Type 
"oxyg" in the search text box.  The list box below should then display oxygen since it 
is the only chemical in the database with the substring "oxyg".  Add oxygen to the 
case study.

Add water, carbon dioxide and nitrogen (in that order) by using the any of the 
options just discussed.  

View the data for phthalic anhydride by double clicking on it in the list chemicals in 
the case study (or single click on its name in the list and click on the View/edit 
chemical button).  Change the impact value for Fathead minnow LC50 to 9.4 
mg/L.  Click on the Calculate scores button to update the normalized score in the 
text box on the right.  Restore the literature value by clicking on Restore Default 
Values.  Click OK to return to the Add chemicals screen.

For practice, let’s add the wrong chemical to chemical list and then delete it.  Click 
on the Search by CAS Number option button.  Add p-chloronitrobenzene (CAS 



number: 100-00-5) to the case study.  Delete this p-chloronitrobenzene by clicking 
on its name in the list of chemicals in the case study and clicking the Delete 
Chemical button.

Click here for screen shot of what Add chemicals screen should look like.

Click OK to close the Add chemicals screen.

Click here to proceed to the next step.



Adding streams to the Unit 700 case study

The next step is to add input and output streams to our case study.  Click on 
Edit/Add Streams to open the Add streams screen (Step 2d).  

The units for our flowrate data is in kg/hr.  To display the proper units first click on 
the Options button.  Make sure that "kg" is selected on the Mass units combo box 
and "hr" is selected on the Time units combo box.  We are going to add stream 
data using the mass fractions of the components so make sure that the mass 
fractions option is selected in the component data frame.  Click on the OK button 
to return to the Add streams screen.

Click on the Add stream button (it should be flashing).  Enter "Air feed" as the 
name for the first stream (in the text box below the Delete button).  

Click on the box below the stream name in the grid to choose a stream type.  
Choose "Inlet" from the drop down list.  The column width can be resized if 
necessary.

Click on the box below the stream type and enter a flow rate of 63967 kg/hr.

The Air feed stream contains only oxygen and nitrogen so enter a mass fraction of 
0.2330 for oxygen and 0.7670 for nitrogen.  All other components have a mass 
fraction of zero for the Air feed stream.

Enter data for the remaining streams as follows:

Name o-Xylene feed Waste gas Maleic anhydride Phthalic anhydride

Type Inlet Outlet Waste Outlet Waste Product

Flow rate 10469 62634 1750 10044

X(PHTHALIC ANHYDRIDE) 0.0000 0.0016 0.0412 0.9993

X(MALEIC ANHYDRIDE) 0.0000 0.0014 0.9588 0.0007

X(o-XYLENE) 1.0000 0.0025 0.0000 0.0000

X(OXYGEN) 0.0000 0.0089 0.0000 0.0000

X(WATER) 0.0000 0.0947 0.0000 0.0000

X(CARBON DIOXIDE) 0.0000 0.1075 0.0000 0.0000

X(NITROGEN) 0.0000 0.7833 0.0000 0.0000

Click on the Check mass balance button.  A message box should indicate that the 
total inlet flow rate is nearly equal to the outlet flow rate (within 1%).

Click here for screen shot of what Add streams screen should look like.



Click OK to close the Add streams screen.

Click here to proceed to the next step.



Completing the Unit 700 case study

The user has the option of including the energy consumed by the process into the 
calculation of its environmental friendliness.  It is up to the user to determine this 
amount.

For this case study, enter an energy usage of 62,035 MJ/hr (in the text box next to 
Step 2e).

Select "Coal" for the fuel type.

Click OK to complete the addition of the case.

Click on the Edit Cases button (next to Step 3).  Click on the View/Edit Chemicals 
button and verify that the list of chemicals in the case study is correct.  Click on the 
View/Edit Streams button and verify that the stream data is correct.

Click OK to return to the main screen.

Click the View/Edit Weights button (next to Step 4) to open the Impact weights 
screen.

The weights for all the impact categories are set to unity by default.  The weights 
can be adjusted by typing in the text boxes provided or by dragging the slider bars.  
For example the acidification potential can be more heavily weighted by moving its 
slider bar to 3.  For this tutorial we want to keep all the weights equal to unity.  Click 
on the Default button to set all the weights equal to unity.

Click OK to return to main screen.

Save the case history file by selecting Save case history file as ... from the File 
menu.  Save the file as "tutorial.war".

Note: A complete case history file for the tutorial ("unit 700 (for tutorial).war") is 
included in the MyFiles directory.

Click here to proceed to the next step.



Adding the Unit 701 Case Study

In the next case study (Unit 701), phthalic anhydride is produced from naphthalene.  
The process flow diagram for this process is as follows:

 

Instead of inputting all of the data manually as we did for the previous case study, 
we will import the data for this case study directly from an ASPEN Plus report file.

Click here to proceed to the next step.



Importing unit 701 case study information from ASPEN

The program will read in chemical and stream information that is found in an 
ASPEN PLUS report file (.rep).  For chemical information, the program will focus on 
the formula for the chemicals.  If there is only one match in the WAR database for a 
particular formula, the program will automatically assign the chemical name and 
CAS number associated with that formula.  The user should verify that the program 
has assigned the correct chemical to the case study.

If more than one match is found in the WAR database for a particular formula, the 
user will have to select the proper chemical by double clicking on that chemical in 
the grid. 

Begin importing the file by clicking on the Import case study from ASPEN button.

Select "napthalene.rep" from the list of files in the MyFiles directory and click on 
Open.

Click here to proceed to the next step.



Completing the Unit 701 case study

Click the Finish button to finish importing the ASPEN file.

The program informs us that it had to convert from molar flowrates to mass flow 
rates and reminds us to check the stream types for each stream.  Finally it signals 
the completion of file import.

Clicking on the finish button opens the Edit case screen automatically.

Change the name of the case to "Unit 701" (in the case name field).

Enter "naphthalene feed stock" in the case description text box.

Click on the View/Edit Chemicals button and verify that the list of chemicals in Unit 
701 is correct.  Click OK button to return to the Edit case screen.

Click on the View/Edit Streams button.  Phthalic anhydride is the product for our 
process so change the stream type for the PHTHANHY stream to "Product".  Click 
OK button to return to the Edit case screen.

Enter an energy usage of "59592" MJ/hr in the text box next to Step 1e.

Select "Coal" for the fuel type.

Click OK to complete the addition of the case.

Click the Save toolbar button.

Click here to proceed to the next step.



Viewing the results graph (tutorial)

Click on the View Results Graph button (Step 5).  The calculation results using the 
default options are now displayed.  

For help in interpreting the results of the WAR GUI, click here.

According to the graph the total output rate of potential environmental impact (PEI) 
is higher for Unit 701 than it is for Unit 700.  The main reason is that the 
naphthalene fed process produces a byproduct stream containing naphthoquinone 
that is a relatively toxic chemical.

In terms of the generation rate of PEI, the impacts of the processes are roughly 
equivalent.  The PEI generation rate is calculated by subtracting the environmental 
impact of the input streams from that of the output streams.  Thus as the inherent 
toxicity of the input streams increases, the PEI generation rate decreases.  The 
naphthalene input stream is inherently more toxic than the o-xylene stream, which 
explains why here the cases yield approximately equivalent results.

Also shown on the Results graph are the output and generation rates of PEI per 
mass of product.  These are useful indicators for cases in which the product flow 
rates are significantly different.  In this example the product flow rates in both cases 
are nearly equivalent so that the results are the same as those given by the indexes 
in units of PEI/time.

To edit the display options select Options from the Graph menu.  Check the 
Include product stream in analysis box and click OK.  The difference in the PEI 
between the cases does not change since both processes had the same product 
flow rate.  Return to the Options screen and uncheck the Include product stream 
in analysis box.

Now uncheck the Include energy in analysis box and click OK.  The total output 
rate of PEI for each unit should have decreased slightly.  Return to the Options 
screen and recheck the Include energy in analysis box.

Now we would like to compare the processes in terms of the individual impact 
categories.  Return to the Options screen and check the Individual impact 
categories box.  Checking this box enables one to choose a PEI index to display.  
For this example choose the generation index (in units of PEI/time).  Click OK to 
return to the Results graph.  From this graph it is apparent that Unit 700 has a large 
negative contribution to the PEI generation rate from the PCOP (smog formation) 
category.  Suppose for example that the plant was located in a remote area so that 
this category is not relevant.  To remove the influence of the PCOP category on the 
total impact, return to the main screen by clicking on the Back to main button, then 
click on View/Edit Weights, change the weight for photochemical oxidation to zero, 
click OK, and return to the graph by clicking View Results Graph.  Now the results 



indicate that Unit 701 has a significantly lower impact generation rate.  Return to the 
Impact weights screen and reset the weights to the default values.  Click OK to 
return to the Main screen.

Return to the Results graph options screen and uncheck the Total impact box, and 
click OK.  Now only the individual categories are displayed.  Displaying only the 
individual categories is useful to more easily see the differences in the individual 
categories.

It is up to the user to decide on to evaluate all of the options discussed here.  The 
user should apply a weighting profile that is appropriate for their specific location 
and concerns.  The user must also decide on how to evaluate the results presented 
by the program, i.e. is it more important to look at output or generation, and is it 
more important to look at PEI/time or PEI/production rate.  Most likely, the user will 
find useful information from combinations of those discussed above.

Return to the Results graph options screen, select Black and white (in the patterns 
box), and click OK.  Now the impact data bars are shaded instead of colored.  This 
is a useful option for printing the graph on black and white printers.

To print the graph, select Print... from the Graph menu.

Suppose for example that we would only like to change the plot order on the graph.  
Choose Select cases to plot from the Graph menu.  Add both cases by clicking on 
Add all cases.  Click on Unit 700 in the selected cases list and click on the Move 
down button.  Click OK to confirm the changes to the plotted cases.

Click on Back to Main button to return to the main screen.

Click here to proceed to the next step.



Viewing the results table (tutorial)

Click on the View Results Table button (Step 5).  The calculation results are now 
displayed in tabular format.

The displayed results can be changed by selecting Options from the Table menu.  
The available options are similar to the graph options in the previous section of the 
tutorial.  However, if one selects the Total PEI indexes option from the Displayed 
data set of radial buttons, the results table also displays the contribution of the 
energy generation process to the PEI indexes.

If one desires to print the table as it appears on the screen, select Print... from the 
Table menu.

To display a text version of the table, click on View as text on the Table menu.  
The table can be printed by selecting Print... from the Results File menu.  

Return to the main menu.

Click here to proceed to the next step.



Viewing the energy comparison graph(tutorial)

Open the Energy comparison graph by clicking the View Energy Comparison 
Graph button.

This graph allows one to compare the contributions of the chemical process and the 
energy generation process to the PEI indexes.

Edit the display options by selecting Options from the Energy Graph menu.  Click 
on the Default button to restore the default options.  Click OK to return to the 
Energy comparison graph screen.

The graph should now illustrate that the contribution of the energy generation 
process to the output PEI Index is significantly less than that of the chemical 
process (for this example).  

Now we would like to compare the relative effects of the energy generation process 
to the chemical process for a given case study for all the individual categories.  
Return to the Options screen.  Select the Display results for all the impact 
categories for the following case study: option.  Once this option is chosen one 
has to pick a case study to evaluate.  Choose "Unit 700" from the list box below this 
option.  Click OK to return to the graph.  

The graph now illustrates that the only significant contribution from the energy 
generation process to the Total PEI comes from the acidification potential.

As a final example we will now compare the contributions of the energy generation 
processes to that of the chemical processes for the acidification potential for the 
different case studies.  Return to the options screen.  Select the Compare case 
studies for the following impact category: button and select AP from the 
category drop down list.  Return to the graph.  The graph now illustrates that the 
energy generation process is the sole contributor to the energy generation process 
for both case studies and that Unit 701 contributes less to the acidification potential 
(since it has a lower energy consumption rate).

Return to the main screen.

Click here to proceed to the next step.



Creating a results file (tutorial)

Previously we created a table that displayed impact results for one set of options at 
a time.  Now we will create a text file that displays the impact calculation results 
several different ways.  The text file will also give a stream report, a chemical report, 
and list the weighting profile.

To create a results file, first click on the Create results File button (Step 6).

Uncheck the box for Include product stream in analysis.

The default text file name is the same as the case history file name with a "txt" 
extension instead of a "war" extension.  If desired, change the file name by editing 
the path in the text box or by selecting the Browse... button.

To create a space delimited text file, make sure Space delimited is selected in the 
text file options box.

To create (and consequently view the file) click the OK button.

Once the text file is displayed it can be edited (i.e. to add additional notes).

If desired save the file by selecting Save as... from the Results File menu.

If desired print the text file by selecting Print... from the Results File menu.

Click on the Close button to return to the main menu.

Click here to proceed to the next step.



Using additional features in the options menu

In this portion of the tutorial we will add a fictitious chemical to the database, view its 
affect on the average impact scores, and remove it from the database.

Select View average impact scores from the Options menu.  These scores are 
the average scores used in the denominator of equation 6.

Record the first 4 scores on a piece of paper for reference later.

Return to the main screen (click on Back to main).

Now we will add the fictitious chemical "methyl ethyl death" to the database.

Select Add chemical to database from the Options menu.

Type "methyl ethyl death" for the chemical name.

Type "999-99-99" for the CAS number.

Type "C6H12O2" for the chemical formula.

Type "116.0" for the molecular weight.

Input the following impact values:

Rat oral LD50: "1000"

OSHA TWA PEL: "100"

Fathead minnow LC50: "100"

Global Warming potential: "5"

Click on the Calculate scores button to calculate the normalized scores for the new 
compound.

Click Add to add the chemical to the database.

Now view the average impact scores again- the values should have changed slightly.

Now we will view the chemical we just added to the database.

Select Edit chemical in database from the Options menu.

Select Search by CAS Number option.



Enter the CAS number for methyl ethyl death (999-99-9) in the search text box.

When the correct CAS number is highlighted in the list box click View/Edit 
Chemical.

Verify that the impact data for the chemical is the same as that which you entered.

Click on Delete from database to delete the chemical from the database.

Click OK to return to the main screen.

This concludes our tutorial.
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